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IN THIS CHAPTER

1

Introducing ArcGIS 3D Analyst 1
• What can you do with 3D Analyst?

• Tips on learning 3D Analyst
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2 USING ARCGIS 3D ANALYST

What can you do with 3D Analyst?
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3D view of raster and vector data

3D view of utility poles and power lines

Viewing a scene from another perspective with another viewer

What can you do with ArcScene?
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Visualizing data
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INTRODUCING ARCGIS 3D ANALYST 3
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Creating surfaces
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Exaggerating the vertical dimension of a scene
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TIN and raster surfaces

Slope and aspect rendering of surfaces

Contours and steepest paths

Analyzing surfaces
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What can you do with ArcMap?

-���������������������������
����������������������

������

���5��	��
��
�������
�����
'��������'����������
��������������
���/��������5���������
�������
������������>�-�����
�������������
�

��������
����
�������������5��%����

�������������
��'���������

'�������
�������'���	��������

���'
��������*�������'�����������

ch01.p65 05/13/2002, 11:41 AM3



4 USING ARCGIS 3D ANALYST
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Line of sight created on a TIN in ArcMap, displayed in ArcScene

3D line graphic created on a raster in ArcMap and a profile graph of the
line.

ArcCatalog lets you browse your data and create and preview layers in
3D.

Navigate the 3D preview; identify features, raster cells, and TIN
triangles.
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What can you do with ArcCatalog?
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INTRODUCING ARCGIS 3D ANALYST 5

Tips on learning 3D Analyst
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Finding answers to questions
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Quick-start tutorial 2
• Copying the tutorial data

• Exercise 1: Draping an image over
a terrain surface

• Exercise 2: Visualizing
contamination in an aquifer

• Exercise 3: Visualizing soil
contamination and thyroid cancer
rates

• Exercise 4: Building a TIN to
represent terrain

• Exercise 5: Working with
animations in ArcScene
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8 USING ARCGIS 3D ANALYST

Copying the tutorial data
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10 USING ARCGIS 3D ANALYST
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Turning on the 3D Analyst extension
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Exercise 1: Draping an image over a terrain surface
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12 USING ARCGIS 3D ANALYST
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20 USING ARCGIS 3D ANALYST

Exercise 2: Visualizing contamination in an aquifer

���%�������������$��&�*�����$�������������"�/��������������
�$�����*������������$����������������%��������#�����
�?>(�����������&�����������������"�
����������*��������
��#���������������##��������#�������*�?>(��������
�,��*������������$�������������������������������#��**������
��������#�'����������� �������!������*�����#��'���"


�����*����������*�������������������������'���������'���
�������������$����������"�+���$��������*��������������
'����������������������#��'���"

?>(������$�����##���������������*�����
�����'�����3����
������L�������
��������"

Opening the Groundwater scene document

/������������������������������/�4���������$���������#�
�*�����������������#�����������������������$�����
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���$����������������*�#�����������$����"�+���$�������#�����
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'������%�*����������������%��������������������!���������
$����*��������������������$������������������������%�����'�
����������������������'������������������%�� ��"

6" ���
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����������&�5��������������&�>#��"

�" (���&�������$����"�!�"
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����������������'����*���������"

Showing the volume and intensity of
contamination

+��9������#��������������*�?>(������������������������/�4
�*�����������������#��������*����������$���������������
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22 USING ARCGIS 3D ANALYST

Showing the relationship of the plume to wells

+����������������������*�����$���������$����������������*
����#����"�I�$��������������**�������������$�����$��������
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+���������������#������$���������$����������������������
��������������#����"�4�$�����$��������*������������������$
����#���������*���������*��������������������'�������%�����*��
������#"

Showing the facilities with a high cleanup priority


������������������#����������������&�������*���������
��������%����������%������*���������#�����������������"
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C" (���&�����
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/���*����������������$��!����������#��#���������������
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Exercise 3: Visualizing soil contamination and thyroid cancer rates

���6DEB���*����������������#��������������������(�����'��
��������#�$���#��������2&������������%����������*
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���������������������� �����"����������!������������$����������
�$�����*�����*����#�����������������������3������"�>������
�*�#�����������������������������*������(
6�C
��������������"�(
6�C���������*��������������������������#��
���������'��������������"�/��������������*�#���������$�����
�������*������������������%%��%�����'������������$�������
���#���#�����#�������������������������������"

/���(
6�C���������������������������������������$��
��##���������������*�������������������
�&�����
	�������������2���������"

Viewing the point data

5����������$�����#�������(�����'����������������$�����#����
����"

6" (���&�5������������&�>#��"

/���(
6�C��������������������������$��$���������
#��������'���������%���%������������������#�������$����
�����������*������������������"�/������������9��������
��������������������$��$�������%������'���������%��
��**���������������#"

Creating 3D point features

/��������(
6�C����#��������-��#������$��������������'����"
>���$���������$�-��#���������������'��������%�����!�������
�!#��������������'�������%��"�+�����������������#�������
 ��������������*������9��%���������������$�������'����������
���$���������$�������������������������'�������%���*�����
���*���������������'���"

5���������9��������������
�����������'������
��
����"
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6" (���&�?��$��#��������/���'�������������&����
������" �" (���&�������#���5�����������#��$���������������&
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6�C"
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(
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��#���5�������
����'�������#��$���������������&
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(
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Increasing the vertical exaggeration

+���$�����!�%%����������������������$�������$�#������$���
���������%�����'�������������*�������%�������"

6" (���&�?��$���������&�
�����7��#������"

�" (���&�(���������5����	!����"

<" (���&�>H"

=" (���&�����5����	!�����'�����"

�

-" (���&���������������'"

4�$������������������������$����#�������������������
��������������**��������%�����(
6�C����#���#����������"

B" 2�����&�����'�!����������'����*����������'�����

�'���#��M6DD<M(
6�C���������&�������������%��'�����
����'�!�������������������*�������"

Extruding columns

?��$��%�#�������������#�����������$�������������%��������"

�������$����������!������#������������������"�+���$���
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-" (���&�����	!����������'" B" (���&�>H��������	!#��������3������������%�'�!"

C" (���&�>H��������:�����7��#������������%�'�!"

4�$�����������������������#�������������$��$�����������
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6�C
��������������������������������������%��������������"

Creating a surface from point sample data
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Viewing the interpolated surface

4�$�������������*��������'�������������������������������
��������������������$��������$�����������%����������������
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4�$����������������������#����������*�����*�(
6�C
�������������������%�$��������������������������������"
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4�!�������$���������������#����������������$�������
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Selecting features by an attribute
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<" (���&�����OP�'�����"

/�����������$�������%���'�����������������������������
��������"

Viewing the attributes of features
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Exercise 4: Building a TIN to represent terrain
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Creating a TIN from point data
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Exercise 5: Working with animations in ArcScene
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Opening the Animation scene document
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Capturing Perspective views as keyframes to
make an animation
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Playing back your animation
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Clearing an animation

�*�����$���������������������������������������������&�����
�������"���������������������9������������������&������Q���
���������������������#�������������������"

6" (���&�
�����������������&�(�����
��������"


�����������������&��������������*�������������"

Recording navigation


�������$��������������������������&�*������������������
�����������������������$�������������%��������������"��������
�������������$�������������������$��*�����������$��������
����%��������%�����5�������"

6" (���&�����5�������������������%����������'��"

/���5������������$���������*��������%�������������"

�

�

-" (���&������������'�����������������������%�����
����%�����"


��
�����'�%������������%��������������������&����
�������'�����"��*��������9������%������%����$��������
����&�$������*���������"

�

ch02.p65 05/13/2002, 11:43 AM55



56 USING ARCGIS 3D ANALYST

�" (���&���������������������*���������������������������5��
����"�+���������*����%�'���������%�������������%�����"

�

=" 7�����	���������#�*����%"

+���������������#�*����%�'������&��%�������������#������
 ���"

B" (���&�����
��#�'���������*��������������%"

�

�

�

���������������������$#�����*����$������������"�7�������
������������������$����������&"

<" (���&��������������'�%���*����%������%�����������"

7��������������������������$�����������"�(���&��%������
���������������#����������%�������&�����������������
�#���"�+�����#�������������������������������'���������
��$�����*����������*�����
��
�����$����$"

+����������������������*��%���#���������%��������������
����$������������&������'�%���$������������&������
�������'����������������$������������&�������
��#
'�����"

C" (���&�����5����	!�����'�����"

�

E" (���&�����7����'���������������������������������������"

ch02.p65 05/13/2002, 11:44 AM56



QUICK-START TUTORIAL 57

���������������������$��%����������������������������
��������������&��������������&����'�������������������!�
�������"

D" (���&�
�����������������&�(�����
��������"




Making a camera track from 3D bookmarks
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Switching the visibility between layers using a
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Using the Animation Manager to disable a track
from playing
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Using Animation Controls to adjust the playback
duration
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Moving an object along a predefined path
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Creating a camera flyby from a path

+�������������������������%���*��%���#����������������$��
����Q����������������������%���#���"�4�!������9������'���
��������&�������������������������#�$�������������$����#����
������������������25>�������*����"

6" (���&�5��%���7�������&��������������������������*�������
#����������������������������������&�5��%���7���"

+��9���������������������������������#����*�������������
���������������*����������������$����%����������'�����
�����%��#�����*����$�����������$�����25>���������������
�����"

-" (���&�?��$��#��������3��&���&������������&�25>"

�" (���&�
�����������������&�(������5��'��*����7���"

ch02.p65 05/13/2002, 11:44 AM65



66 USING ARCGIS 3D ANALYST

=" (���&���#���"

B" (���&�����7����'�����"

<" (���&�����������#�����������������#����"

/�����#���������������'����������25>�����������������%
����#���"

C" 2�����&�����/�#�"��������&�'�!������&�����������
#���������'��"

/����������������#�����%�����,���&��"�4�!������9��������
��$������Q���������������������������������������#�����%���
��������������������**���"

E" (���&�>#�����"

�

�

3��������&��#���"�/���25>����������������������������
*����$���������������"

�

�

�

ch02.p65 05/13/2002, 11:44 AM66



QUICK-START TUTORIAL 67

D" /�#��J�GK�������������������!��'�!" Saving an animation in a scene document
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70 USING ARCGIS 3D ANALYST

What are surfaces and surface models?
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Raster surfaces
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Surface model of chemical concentration across an area with
points showing where the concentration was sampled

Higher precision grid Lower precision grid

Grid in perspective view
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Nodes and edges of a TIN Nodes, edges, and faces

TIN in perspective view

TIN surfaces
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Creating raster surfaces from points
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What is interpolation?
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Why interpolate?
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High

Low
On the left is a point dataset of known values. On the right is a raster
interpolated from these points. Unknown values are predicted with a
mathematical formula that uses the values of nearby known points.
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Interpolation methods
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Details on the interpolation methods
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Inverse Distance Weighted
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Fitting a model to the empirical semivariogram
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Understanding a semivariogram—the range, sill, and
nugget
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Interpolating a
raster surface
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Interpolating using
Inverse Distance
Weighted with a variable
search radius

1. Click 3D Analyst, point to
Interpolate to Raster, and
click Inverse Distance
Weighted.

2. Click the dropdown arrow and
choose the input point data
source.

3. Click the field that contains
the attribute data that you
want to interpolate.

4. Type the power.

5. Click the dropdown arrow and
click Variable.

6. Type the number of points to
use as input from within the
maximum distance.

7. Type the maximum distance
to search for points to use in
the interpolation.

8. Optionally, check the box and
select or navigate to a feature
class to use as barriers to
interpolation.

9. Type a cell size for the output
raster.

10. Optionally, type a name for
the Output raster. If you do
not, the raster will be
temporary.

11. Click OK.

Tip

What is the power?
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What is a variable radius?
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What are barriers?
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Interpolating using
Inverse Distance
Weighted with a fixed
search radius

1. Click 3D Analyst, point to
Interpolate to Raster, and
click Inverse Distance
Weighted.

2. Click the dropdown arrow and
choose the input point data
source.

3. Click the dropdown arrow and
choose the field that contains
the attribute data that you
want to interpolate.

4. Type the power.

5. Click the dropdown arrow and
click Fixed.

6. Type the distance within
which to search for input
points.

7. Type the minimum number of
points that must be included
in the interpolation for a cell.

8. Optionally, check the box and
select or navigate to a feature
class to use as barriers to
interpolation.

9. Type a cell size for the output
raster.

10. Optionally, type a name for
the Output raster. If you do
not, the raster will be
temporary.

11. Click OK.

Tip

What is the Minimum
Count?
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Interpolating using a
Tension spline

1. Click 3D Analyst, point to
Interpolate to Raster, and
click Spline.

2. Click the dropdown arrow and
choose the input point data
source.

3. Click the dropdown arrow and
choose the field that contains
the attribute data that you
want to interpolate.

4. Click the dropdown arrow and
click Tension.

5. Type a weight.

6. Type the minimum number of
points that must be included
in the interpolation for a cell.

7. Type a cell size for the output
raster.

8. Optionally, type a name for
the Output raster. If you do
not, the raster will be
temporary.

9. Click OK.

Tip

What is a Tension spline?
#�
��	
��	
��������	�
�	
���������
����	��	
����
������������
�����
��	
�
����	
%��������
��������
��
��	
����������
�	����&����
�	�
�����	����������������	��������	
�
�
�
�����

	�
�
��	
�$�&�����

��
������������
�	�	�&��������
�������

Tip

What is the weight value?
������	����������	
�����

	�


��	
����'�
�
��������
�	�	�&�������

��������#���	������� ���
���
�	
��
��
	����	
�������
��	
��	
��������
�	�
��������������
�	
����
�����
���
�	�	�&��������
���������&�	���
��	���������
����� $�($�!$��
��( �

Tip

What is the number of
points?
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Interpolating using a
Regularized spline

1. Click 3D Analyst, point to
Interpolate to Raster, and
click Spline.

2. Click the dropdown arrow and
choose the input point data
source.

3. Click the dropdown arrow and
choose the field that contains
the attribute data that you
want to interpolate.

4. Click the dropdown arrow and
click Regularized.

5. Type a weight.

6. Type the minimum number of
points that must be included
in the interpolation for a cell.

7. Type a cell size for the output
raster.

8. Optionally, type a name for
the Output raster. If you do
not, the raster will be
temporary.

9. Click OK.

Tip

What is a Regularized
spline?
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What is the number of
points?
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Creating a surface using
Kriging interpolation with
a variable radius

1. Click the 3D Analyst
dropdown arrow, point to
Interpolate to Raster, and
click Kriging.

2. Click the dropdown arrow and
click the Input points dataset.

3. Click the Z value field
dropdown arrow and click the
field you wish to use.

4. Click the Kriging method you
wish to use.

5. Click the Semivariogram
model dropdown arrow and
click the model you wish to
use.

6. Click the Search radius type
dropdown arrow and click
Variable.

7. Optionally, change the default
Number of points.

8. Optionally, specify a Maxi-
mum distance.

9. Optionally, change the default
Output cell size.

10. Optionally, check the Create
Prediction of standard error
check box.

11. Specify a name for the
outputs or leave the default
to create a temporary dataset
in your working directory.

12. Click OK.
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interpolation
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Creating a surface using
Kriging interpolation with
a fixed radius

1. Click the 3D Analyst
dropdown arrow, point to
Interpolate to Raster, and
click Kriging.

2. Click the dropdown arrow and
click the Input points dataset.

3. Click the Z value field
dropdown arrow and click the
field you wish to use.

4. Click the Kriging method you
wish to use.

5. Click the Semivariogram
model dropdown arrow and
click the model you wish to
use.

6. Click the Search radius type
dropdown arrow and click
Fixed.

7. Optionally, change the default
Distance for the search radius
setting.

8. Optionally, change the
Minimum number of points.

9. Optionally, change the default
Output cell size.

10. Optionally, check the Create
Prediction of standard error
check box.

11. Specify a name for the
outputs or leave the default
to create a temporary dataset
in your working directory.

12. Click OK.
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Deciding on the radius or
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Changing the lag size,
major range, partial sill,
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Interpolating using
Natural Neighbors

1. Click 3D Analyst, point to
Interpolate to Raster, and
click Natural Neighbors.

2. Click the dropdown arrow and
choose the Input points data
source.

3. Click the dropdown arrow and
click the height source.

4. Type a cell size for the output
raster.

5. Type a name for the Output
raster.

6. Click OK.

Tip

What is a Natural
Neighbors interpolation?
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1. Click 3D Analyst and click
Options.

2. Click the General tab.

3. Type the name of the new
working directory.

Alternatively, you can browse
to your new working directory.

4. Click OK.

Saving all rasters
in a specified
location
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1. Click 3D Analyst and click
Options.

2. Click the General tab.

3. Browse to the raster that will
be the analysis mask.

4. Click OK.

Setting an
analysis mask
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Setting the
coordinate
system for your
analysis results
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1. Click 3D Analyst and click
Options.

2. Click the General tab.

3. Click the Analysis Coordinate
System option you wish to
use to save your analysis
results into either the coordi-
nate system of the input
raster or the coordinate
system of the data frame.

4. Click OK.
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Setting the output
extent
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Specifying an extent for
analysis results

1. Click 3D Analyst and click
Options.

2. Click the Extent tab.

3. Click the Analysis extent
dropdown arrow and choose
an option to specify the
extent for all subsequent
analysis results.

4. Click OK.

Tip

Setting the Snap extent
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Setting the cell size

1. Click 3D Analyst and click
Options.

2. Click the Cell Size tab.

3. Click the dropdown arrow and
choose the method of
determining the cell size.

4. Optionally, type the number of
map units to define the cell
size.

5. Optionally, type the number of
rows and the number of
columns to define a cell size.

6. Click OK.

Setting the output
cell size
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Tip

Overriding the default cell
size
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Creating TIN surfaces from vector data

Mass points, categorized by height attribute

Breaklines
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Clip polygon
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The graphic on the left shows a TIN created from mass points; the graphic
on the right shows a TIN of the same area created from mass points and
breaklines.
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Building a TIN
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Creating a TIN

1. Click 3D Analyst, point to
Create/Modify TIN, and click
Create TIN From Features.

2. Check the features that you
want to use in building your
TIN.

You can use the browse
button beside the Layers list
to navigate to other feature
classes to include in the TIN.

3. Click the dropdown arrow
and choose the Height
source field.

You can choose shape
geometry if the features have
3D geometry.

4. Click the dropdown arrow
and choose how the features
should be incorporated into
the TIN—as mass points,
breaklines, or polygons.

5. Optionally, click the
dropdown arrow and choose
the Tag value field if you wish
to tag the TIN features with a
value from the input features.

6. Repeat steps 2 through 5 for
each input feature class.

7. Type a name for the TIN.

8. Click OK.
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Adding features to a TIN

1. Click 3D Analyst, point to
Create/Modify TIN, and click
Add Feature to TIN.

2. Check the features that you
want to add to the TIN.

You can use the Browse
button beside the Layers list
to navigate to other feature
classes to include in the TIN.

3. Click the dropdown arrow and
choose the Height source
field.

You can choose shape
geometry if the features have
3D geometry.

4. Select how the features
should be incorporated into
the TIN—as mass points,
breaklines, or polygons.

5. Optionally, click the dropdown
arrow and choose the Tag
value field if you wish to tag
the TIN features with a value
from the input features.

6. Repeat steps 2 through 5 for
each input feature class.

7. Click OK.

Tip

Adding the selected
features to a TIN
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Creating a TIN
from a raster
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Converting a raster to a
TIN

1. Click 3D Analyst, point to
Convert, and click Raster to
TIN.

2. Click the dropdown arrow and
click the raster that you want
to convert to a TIN.

3. Type a vertical accuracy for
the TIN.

4. Optionally, check the box to
limit the number of points
added to the TIN in pursuit of
accuracy.

5. Optionally, type the maximum
number of points to add to
the TIN in pursuit of accuracy.

6. Type a name for the Output
TIN.

7. Click OK.
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Tip

What is the vertical
accuracy?
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Creating a raster
from a TIN
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Converting a TIN to a
raster

1. Click 3D Analyst, point to
Convert, and click TIN to
Raster.

2. Click the dropdown arrow and
click the TIN that you want to
convert to a raster.

3. Click the Attribute dropdown
arrow and click the attribute
of the TIN that you want to
save as a raster.

You can choose from eleva-
tion, aspect, slope in percent-
age, and slope in degrees.

The TIN must have already
been symbolized by the
attribute in your scene or
map.

4. Optionally, set a Z factor.

5. Optionally, type the Cell size
for the raster.

6. Type a name for the Output
raster.

7. Click OK.

�Tip

What is the Z factor?
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Managing 3D data 4
• ArcCatalog basics
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• Creating a new 3D feature class


��(�����%�����$�������������%���������������������������$�����������
����%�������*��������������
�����"�+�����������
��(�����%������%��� ������
$��&.��#���#��������������������������������������(�����%����������%����%
�������#������������������������&���"�+���������������7�����$���'���������
#�����������#�����$��*��������������$�����������%��#����#��������#�����$���
����������%��������?��$��#����"�+�������������������������*��������-�
�������������%��������$��%�#��#������.*����!��#��������������������'���
���%���������!���������!#���������*���*��������$���� ��������������������
�����'���"�+����������������������$�����������������������������%������
����%��������������������#���*��$��������������*�������������������'����
���������#������������������������%���������"����������������������������
������������������%�#���#����������$�����'�����%��#������*������������"

ch04.p65 05/13/2002, 11:46 AM99



100 USING ARCGIS 3D ANALYST

ArcCatalog basics
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Large Icons

List Details

Thumbnails

Catalog tree and contents of a folder connection
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Previewing data
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Large Icons

List Details

Thumbnails

Browsing the Catalog’s contents
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Geography and table previews—the Z in the Shape field indicates a
geometry that contains z-values.
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Metadata viewed with the FGDC FAQ stylesheet

Search for data with metadata containing the word elevation.

Search
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Previewing 3D
data
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Navigating in 3D

1. Click the Navigate button on
the 3D View toolbar.

The Navigate tool allows you
to rotate the data in 3D, to
zoom in and out, and to pan
the data.

2. Click on the data and drag it
to the right.

When you click on the data
and drag to the right, you
rotate the data counterclock-
wise around the z-axis.

3. Right-click on the 3D data
and drag down.

When you right-click on the
data and drag down, you
zoom in to the data. �

Tip

Why does my data look flat
in 3D View preview?
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104 USING ARCGIS 3D ANALYST

4. Click both mouse buttons—or
the center button on a three-
button mouse—and drag the
data to the right.

Clicking both buttons and
dragging the data pans the
data.

5. Click on the data and drag
up.

Clicking and dragging the
data up lowers your viewing
position relative to the data.

6. Click the Full Extent button.

The data returns to the
original extent and view
position.

Tip

Seeing the entire dataset
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Centering

1. Click the Center on Target
tool.

2. Click the location that you
want to occupy the center of
the 3D view.

The camera, the
observer, and the
target
������	���� ��	�	� 
��������
��	�	�,����������+����	��,�
����
���� ����� ��	�	� ����	
��	�� �

�	������	��
 ����	�
�����	
����
��
�������
�	����	�����
���	�
	�� ��� ����	�� 
�	� �������
'�	�� ���� ������
	� 
������� �
��	�	#� ���� ��	� ��
������������

�	� � �	��	�� ��� ���!���
���
��
��
�	�
���	
���

The point you clicked is the new center of the view.
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Tip

Centering shortcut
:�����
���
�����
������������	��
�
	
������3��	�����������1��

����
0����%�&��
����	�%�������������	�

������&�����
�������
��������
��
��

Tip

Why change the center of
the view?
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Zooming to a target

1. Click the Zoom to Target tool.

2. Click the location that you
want to zoom to.

Tip

Zooming shortcut
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The view zooms in to the point you clicked.
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Setting the camera
observer

1. Click the Set Observer tool.

2. Click the location that you
want to zoom to.
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Tip

Using the camera tools in
ArcScene
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Set observer shortcut
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The view zooms to the point you clicked, honoring the target.
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Creating a 3D thumbnail

1. Navigate the 3D view to the
perspective that you’d like to
show in a thumbnail
snapshot.

2. Click the Create Thumbnail
button.

3. Click the Metadata tab.

The 3D thumbnail appears.

Tip

Viewing thumbnails in the
Contents tab
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The 3D thumbnail appears in the metadata.
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Displaying 2D
data in 3D
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Creating a layer

1. Right-click the data source
from which you want to
create the layer.

2. Click Create Layer.

3. Navigate to the folder in
which you want to save the
layer.

4. Type a name for the layer file.

5. Click Save.

The layer file is now an item
in the Catalog.

Setting layer properties

1. Right-click the layer.

2. Click Properties.

You can use the Layer
Properties dialog box to set
many properties of the layer
in addition to the 3D Base
Height, Extrusion, and
Rendering properties.
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110 USING ARCGIS 3D ANALYST

Setting base heights
using an attribute

1. Click the Base Heights tab.

2. Click the option to Use a
constant value or expression
to set heights for layer.

3. Click the Calculate button.

4. Double-click the field that will
provide the z-value for the
features.

You can create an
expression, such as [contour]
* 3.28, to set the z-values as
well.

5. Click OK.

6. Click OK on the Layer
Properties dialog box.

The 2D features are now
drawn in 3D using the
attribute that you selected as
the z-value.
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Setting base heights
using a surface

1. Click the Base Heights tab.

2. Click the Browse button.

3. Navigate to a surface.

4. Click the surface.

5. Click Add.

6. Click OK on the Layer
Properties dialog box.

The 2D features are now
drawn in 3D using the
surface that you selected to
provide the z-value.
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Extruding features

1. Click the Extrusion tab.

2. Optionally, type a constant
height to which all features
will be extruded.

3. Optionally, click the Calculate
Extrusion Expression button.

4. Optionally, click the field that
you want to use in the
extrusion expression. You can
build complex extrusion
expressions using functions
and algebraic expressions.

5. Optionally, click Load and
browse to a previously saved
extrusion expression.

6. Click OK.

7. Click the dropdown list to
choose how you want the
extrusion expression applied.

8. Click OK.

The 2D features are now
extruded using the constant
or expression.

Tip

What is extrusion?
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Starting
ArcScene from
ArcCatalog
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Opening an existing
scene from ArcCatalog

1. Navigate to the scene that
you want to open.

You can use the Preview tab
and 3D View tools to preview
the scene before you open it.

2. Double-click the scene in the
Catalog tree.

Opening a new scene
from ArcCatalog

1. Click the ArcScene button on
the 3D View Tools toolbar.
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Creating a new
3D feature class
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Creating an empty 3D
feature class or shapefile

1. Right-click in the location
where you want to create the
new shapefile. Point to New
and click Shapefile.

If you want to create a
geodatabase feature class,
navigate to an existing
geodatabase and click
Feature class.

2. Type a name for the new
shapefile.

3. Click the Feature Type
dropdown arrow and click the
type (geometry) of feature
that you want to create—for
example, point, polyline,
polygon.

4. Optionally, click Edit to define
the spatial reference for the
features.

5. Click the check box to
indicate that the feature
coordinates will contain
z-values.

6. Click OK.

The shapefile is created. You
can right-click it in the
Catalog tree, click Properties,
and add attributes if you want
to store attributes for the 3D
features. You do not need to
include a height attribute, as
the z-values will be stored in
the feature geometry.
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Displaying surfaces 5
• Displaying raster surfaces in 3D

• Displaying raster surfaces

• Symbolizing areas with unknown
values

• Displaying TIN surfaces

• Making a layer transparent

• Shading a layer
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Displaying raster
surfaces in 3D
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Draping a raster on a
surface

1. In the table of contents, right-
click the raster layer that you
want to drape over a surface
and click Properties.

2. Click the Base Heights tab.

3. Click the button to Obtain
heights for layer from surface.

If you want to use a surface
other than the current raster
layer, either select one of the
surfaces in the scene by
clicking the dropdown arrow
or click the Browse button
and navigate to another
surface.

4. Click OK.
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Displaying raster
surfaces
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Drawing rasters that
represent continuous
surface data with
separate classes

1. In the table of contents, right-
click the raster layer that you
want to show by grouping
values into classes and click
Properties.

2. Click the Symbology tab.

3. Click Classified.

4. Click the Classes dropdown
arrow and click the number of
classes you want.

5. Optionally, click Classify and
choose the classification
method you want to use.

6. Click the Color Ramp
dropdown arrow and click a
color ramp.

7. Click OK.

Tip

Why don’t I see the option
to use unique values?
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The continuous surface is drawn with different colors for each class.
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Drawing rasters that
represent continuous
surface data with a
continuous color ramp

1. In the table of contents, right-
click the raster layer that you
want to show with a continu-
ous color ramp.

2. Click the Symbology tab.

3. Click Stretched.

4. Optionally, click the Color
Ramp dropdown arrow and
click a color ramp.

5. Click OK.

Tip

Continuous rasters
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The continuous surface is drawn with a continuous color ramp.
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Drawing thematic rasters
that represent unique
categories, such as land
cover

1. In the table of contents, right-
click the raster layer that you
want to show using unique
categories and click
Properties.

2. Click the Symbology tab.

3. Click Unique Values.

4. Click the Value Field
dropdown arrow and click the
field you want to map.

5. Click the Color Scheme
dropdown arrow and click a
color scheme.

If your raster has a colormap,
click Default Colors to revert
to colors specified in the
colormap.

6. Optionally, click a label and
type in a more descriptive
name.

7. Click OK.

Tip

Categorical rasters
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The categorical raster is drawn with unique colors for each value.
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Stretching a raster to
improve the visual
contrast

1. In the table of contents, right-
click the raster layer that you
want to increase the visual
contrast of and click
Properties.

2. Click the Symbology tab.

3. Click Stretched.

4. Click the Color Ramp
dropdown arrow and click a
color ramp.

5. Click the Stretch Type
dropdown arrow and click the
stretch you want to apply.

6. Optionally, click Histogram to
modify the stretch settings.

7. Optionally, if the raster
contains a background or
border around the data that
you want to hide, check
Display Background Value
and set the color to No Color.

The cells will display
transparently.

8. Click OK.

Tip

What is a stretch?
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The image raster is drawn with a contrast stretch.
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Changing the band color
assignments for a
multiband raster

1. In the table of contents, right-
click the raster layer and click
Properties.

2. Click the Symbology tab.

3. Click RGB Composite.

4. Optionally, uncheck bands to
turn them off.

5. Click the Red, Green, and
Blue dropdown arrows and
select the bands of the raster
that will be displayed in red,
green, and blue.

6. Click OK.

Tip

Why do I only see three
bands when I added a five-
band raster?
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122 USING ARCGIS 3D ANALYST

Adding a single band of a
multiband raster

1. Navigate to the raster.

2 Expand the raster to view the
individual bands.

3. Select a single band and click
Add.

The band is added as a
single-band raster.

Turning bands on and off
in a multiband raster

1. Click the color square beside
the band you want to turn off.

2. Click Visible to uncheck it.

The band is turned off.

Tip

Changing band colors
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DISPLAYING SURFACES 123

Setting the default color
band assignments for
multiband rasters

1. Click Tools and click Options.

2. Click the Raster tab.

3. Click the up and down arrows
to select the bands in the
raster that will be rendered in
Red, Green, and Blue.

4. Click OK.
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Symbolizing
areas with
unknown values
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Setting the NoData or
Background display color

1. In the table of contents, right-
click the raster layer and click
Properties.

2. Click the Symbology tab.

3. Check the box to Display
Background Value.

4. Optionally, type a value to
define the raster’s Back-
ground color.

5. Click the Background color
selector dropdown arrow and
click a color—or no color.

6. Click the Display NoData as
color selector dropdown
arrow and click a color—or no
color.

7. Click OK.

�

�

� �� �

ch05.p65 05/13/2002, 1:41 PM124



DISPLAYING SURFACES 125

Displaying TIN
surfaces
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Drawing TIN faces by
elevation

1. In the table of contents, right-
click the TIN.

2. Click the Symbology tab.

3. Click Elevation.

4. Optionally, click the Color
Ramp dropdown arrow and
click a new color ramp.

5. Optionally, click the Classes
dropdown arrow and choose
the number of classes.

6. Click OK.

The TIN is drawn with different colors for each elevation class.
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126 USING ARCGIS 3D ANALYST

Drawing TIN faces by
aspect

1. In the table of contents, right-
click the TIN.

2. Click the Symbology tab.

3. Uncheck Elevation—or any
other TIN face renderer that
is checked.

4. Click Add.

5. Click Face aspect with
graduated color ramp.

6. Click Add.

7. Click Dismiss. �
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8. Click OK.

The TIN faces are rendered
with colors to indicate the
direction that they face.

�

The TIN is drawn with different colors for each triangle’s aspect class.
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Drawing TIN faces by
slope

1. In the table of contents, right-
click the TIN.

2. Click the Symbology tab.

3. Uncheck Aspect—or any
other TIN face renderer that
is checked.

4. Click Add.

5. Click Face slope with
graduated color ramp.

6. Click Add.

7. Click Dismiss. �

Tip

Changing the slope of a
TIN surface
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8. Click the Color Ramp
dropdown arrow and select a
color ramp.

9. Click OK.

The TIN faces are rendered
with colors to indicate the
slope of the terrain.

The TIN is drawn with graduated colors for each triangle’s slope class.
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Tip

What are tag values?
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Drawing TIN faces by tag
value

1. In the table of contents, right-
click the TIN.

2. Click the Symbology tab.

3. Uncheck Elevation—or any
other TIN face renderer that
is checked.

4. Click Add.

5. Click Face tag value grouped
with unique symbols.

6. Click Add.

7. Click Dismiss. �
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8. Click Add All Values.

9. Click OK.

The TIN is drawn with different colors for each triangle’s tag value.

� 


ch05.p65 05/13/2002, 1:41 PM131



132 USING ARCGIS 3D ANALYST

Drawing TIN nodes by
elevation

1. In the table of contents, right-
click the TIN.

2. Click the Symbology tab.

3. Uncheck Elevation—or any
other TIN face renderer that
is checked.

4. Click Add.

5. Click Node elevation with
graduated color ramp.

6. Click Add.

7. Click Dismiss. �

Tip

How else can I display TIN
nodes?
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DISPLAYING SURFACES 133

8. Click the Color Ramp
dropdown arrow and select a
color ramp.

9. Click OK.

The TIN nodes are rendered
with colors to indicate their
elevation.

In this example, you can also
see the Soft and Hard edges,
which are on by default, if the
TIN has them.
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Drawing TIN edges
grouped with a unique
symbol

1. In the table of contents, right-
click the TIN.

2. Click the Symbology tab.

3. Uncheck Elevation.

4. Click Edge types.

By default, only the type 1
and 2 (Hard and Soft) edges
are displayed.

5. Click Add All Values.

6. Click OK.

Tip

How else can I display TIN
edges?
:�����
���
���	
���&�������3�����

�	�������
����
&����$��
��&�����

�����
���������	
�	�	���������
�&��
�����������	
���&��
	
�����
#���-����
��
���������-����

�����

�

�� �

��

ch05.p65 05/13/2002, 1:41 PM134



DISPLAYING SURFACES 135

Making a layer
transparent
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1. In the table of contents, right-
click the layer and click
Properties.

2. Click the Display tab.

3. Type a value in the
Transparent box.

4. Click OK.
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Tip

How else can I make a
layer transparent?
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Shading a layer
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1. In the table of contents, right-
click the layer and click
Properties.

2. Click the Rendering tab.

3. Check the box to Shade areal
features relative to the
scene’s light position.

The option to Use smooth
shading if possible is checked
by default. This minimizes the
shading of small surface
variations to create a
smoother-looking shaded
surface.

4. Click OK.

Tip

Changing the light source
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Tip

TIN face shading
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Analyzing surfaces 6
• Querying surface values

• Understanding the shape of a
surface

• Deriving slope and aspect
information from a surface

• Creating contours

• Analyzing visibility

• Deriving hillshade from a surface

• Determining height along a profile

• Finding the steepest path

• Calculating area and volume

• Reclassifying your data

• Converting surfaces to vector
data

• Creating 3D features
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Querying surface
values
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Identifying features or
cells by clicking them

1. Click the Identify button on
the Tools toolbar in ArcScene
or ArcMap or on the 3D View
Tools toolbar in ArcCatalog.

2. Click the mouse pointer over
the feature or cell you want to
identify.

Displaying Map Tips for
surfaces

1. In the ArcMap table of
contents, right-click the layer
for which you want to display
Map Tips and click
Properties. �

�

�

�
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2. Click the Display tab.

3. Check Show Map Tips.

4. Click OK.

5. Move the mouse pointer over
a TIN facet or raster cell to
see the Map Tip.

Tip

Displaying Map Tips for
features
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Understanding the shape of a surface
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Slope and aspect in rasters and TINs
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Hillshading surfaces
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3D perspective hillshaded view of terrain and planimetric contour line
representation of the same area

Terrain slope and aspect surfaces. In the picture on the left, darker shades
of red indicate steeper slopes. In the picture on the right, west-facing
slopes are dark blue, and southeast-facing slopes are yellow.
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Deriving contour lines from rasters and TINs
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���������'���>3D perspective view of terrain without and with hillshading

2D elevation raster, transparent hillshade raster, and shaded relief map

Contours created from a raster surface and from a TIN surface
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Calculating slope

What is slope?
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             Elevation grid
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0–7

8–15

16–23

24–31

32–39

40–47

48–55

56–63

64–70

71–78

?���

:�$

    Slope map (in degrees)

Degree of slope = θ

rise

run
= tan θ

Percent of slope =            * 100
rise

run

Degree of slope =        30 45       76

Percent of slope = 58 100 375

ch06.p65 05/14/2002, 10:41 AM142



ANALYZING SURFACES 143

Deriving slope
from a raster
surface
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Deriving slope

1. Click 3D Analyst, point to
Surface Analysis, and click
Slope.

2. Select the surface from which
you want to derive a raster of
slope values.

3. Click Degree or Percent.

4. Type a Z factor. This is
calculated automatically if the
input has a defined spatial
reference that includes z unit
information.

5. Type an Output cell size.

6. Type the name of the Output
raster.

7. Click OK.
Tip

Degree and percent slope
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Tip

Why use a Z factor?
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144 USING ARCGIS 3D ANALYST

Why use the aspect function?
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What is the aspect?
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Calculating aspect
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Deriving aspect

1. Click 3D Analyst, point to
Surface Analysis, and click
Aspect.

2. Click the dropdown arrow and
click the surface from which
you want to derive a raster of
aspect values.

3. Type an Output cell size.

4. Type the name of the Output
raster.

5. Click OK.

Deriving aspect
from a raster
surface
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Mapping contours

What are contours?
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Why map contours?
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Elevation grid and derived contour map

Using contours in a scene
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Contours superimposed on terrain surface model

Feature attribute table for contours
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3D graphic contour copied from a scene into a map

3D graphic contours marking lines of equal elevation
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Contour tool
ArcScene 3D Analyst toolbar

ArcMap 3D Analyst toolbar
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Deriving contour
lines from a
surface
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Deriving contours

1. Click 3D Analyst, point to
Surface Analysis, and click
Contour.

2. Click the dropdown arrow and
click the surface from which
you want to derive contours.

3. Type the Contour interval.

4. Optionally, specify a Base
contour.

5. Optionally, specify a Z factor.

6. Browse to the location where
you want to save the contours
and type a name for them.

7. Click OK.

Tip

What is the offset?
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What is the Z factor?
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Creating a single contour

1. Click the Contour button.

2. Click the surface at the point
where you want the contour.

The contour is added as a 3D
polyline graphic. The height
of the contour is written to the
status bar.
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Analyzing visibility
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What is a line of sight?
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What is the viewshed?
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Why calculate the viewshed?
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Line of sight created in ArcMap and copied and pasted into a 3D scene

Target

Observer

Observer height

Line of sight
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Creating a line of
sight
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1. In ArcMap, click the Line of
sight button on the 3D
Analyst toolbar.

2. Optionally, type an Observer
offset.

3. Optionally, type a Target
offset.

4. Optionally, check the box to
model curvature and refrac-
tion. For this option to be
enabled, the surface must
have a defined spatial
reference in projected
coordinates and defined
z-units.

5. Click the surface at the
observer location, then click
the target location.

Tip

What are the Observer
offset and Target offset?
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Deriving a
viewshed
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Creating a map
displaying the viewshed

1. Click 3D Analyst, point to
Surface Analysis, and click
Viewshed.

2. Click the Input surface
dropdown arrow and click the
input surface you want to
calculate the Viewshed from.

3. Click the Observer points
dropdown arrow and click the
feature layer to use as
observer points.

4. Specify a Z factor. The default
is 1. The Z factor is automati-
cally calculated if the input
surface has a spatial refer-
ence with z-units defined.

5. Specify an Output cell size.

6. Specify a name for the
Output raster or leave the
default to create a temporary
dataset in your working
directory.

7. Click OK.

Tip

Using optional parameters
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Using hillshading in analysis
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What is the hillshade function?
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Computing hillshade
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Sun angle: 45 degrees

Using hillshading for display
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Sun angle: 60 degrees
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Deriving hillshade
from a surface
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Creating a hillshade
raster

1. Click 3D Analyst, point to
Surface Analysis, and click
Hillshade.

2. Click the dropdown arrow and
click the surface from which
you want to derive a hillshade
raster.

3. Specify the azimuth you wish
to use. The default is
315 degrees.

4. Specify an altitude. The
default is 30 degrees.

5. Optionally, check Model
shadows if you wish to
include the shading effect of
surrounding cells. Cells in the
shadow of other cells will be
coded 0.

6. Specify a Z factor. The
default is 1. The Z factor is
automatically calculated if the
input surface has a spatial
reference with z-units
defined.

7. Specify an Output cell size.

8. Specify a name for the
Output raster.

9. Click OK.

Tip

Modeling shadows
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Specifying a Z factor
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Shading a raster with a
hillshade

1. Create a hillshade raster from
the surface raster that you
want to shade (see ‘Creating
a hillshade raster’ in this
chapter).

2. In the table of contents, right-
click the hillshade layer and
click Properties.

3. Click the Display tab.

4. Type a value in the Transpar-
ent box to set the percent
transparency. 50% is a
reasonable value.

5. Click OK.

You should now see the
elevation raster through the
hillshade raster.

Tip

Adding depth in 2D
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Shading 3D
surfaces in a
scene
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Shading a raster surface
in a scene

1. In ArcScene, set the base
height of the raster to itself
(see ‘Displaying raster
surfaces in 3D’ in Chapter 5).

2. Right-click the raster layer in
the table of contents and click
Properties.

3. Click the Rendering tab.

4. Check the box to Shade areal
features relative to the
scene’s light position.

The option to Use smooth
shading if possible is checked
by default. This minimizes the
shading of small surface
variations, which creates a
smoother-looking shaded
surface.

5. Click OK.
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Determining
height along a
profile
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1. In ArcMap, click the Layer
dropdown arrow and click the
surface that you want to
profile.

2. Click the Interpolate Line
button.

3. Click the surface and digitize
a line. When you are finished,
double-click to stop digitizing.

4. Click the Profile Graph
button.

5. Optionally, to change the
layout of the profile graph,
right-click on the title bar of
the profile graph and click
Properties.

Tip

Profiling a 3D line feature
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Finding the
steepest path
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1. Click the Steepest Path tool.

2. Click the surface at the
location where you want the
path to begin.
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Calculating area
and volume
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1. Click 3D Analyst, point to
Surface Analysis, and click
Area and Volume.

2. Click the dropdown arrow and
click the surface for which you
want to calculate area and
volume statistics.

3. Type a height for the
reference plane.

4. Click to calculate above or
below the reference plane.

5. Optionally, type a Z factor to
convert the z units to x,y units
if the z units of the surface
are not the same as the
x,y units.

You will get inaccurate results
if the units are not the same
and you do not include a
Z factor.

6. Optionally, check the box to
save the results to a text file.

7. Optionally, type a name for
the text file where the results
will be saved.

8. Click Calculate statistics.

The 2D area, Surface area,
and Volume will be reported
in the area below this button
and optionally written to a text
file.

You can change the
parameters and click the
button again to repeat the
calculation.

9. Click Done.
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What is reclassification?
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Why reclassify your data?
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Replacing values based on new information

9�������'�����
��������'���������
��������
����������������������
����������������������������������������>�������
������������

'�������
������������������
'�������	�
������&����
'������	���
���
����������������''�����������>�8
���#�&���	������&�����������'����
����������������������������
������&�>

Grouping values together
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Reclassifying values of a set of rasters to a common
scale
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Setting specific values to NoData or setting NoData
cells to a value
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Reclassifying data
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Reclassifying
your data
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Tip

Changing the classes of
your old values
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Replacing NoData values
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Replacing values based
on new information

1. Click the 3D Analyst
dropdown arrow and click
Reclassify.

2. Click the Input Raster
dropdown arrow and click the
raster with a value you wish
to change.

3. Click the Reclass Field
dropdown arrow and click the
field you wish to use.

4. Click the new value you wish
to change and type a new
value.

5. Type the Old values entry in
each New values input box
for all other values to keep
them the same in the Output
Raster.

6. Optionally, click Save to save
the remap table.

7. Specify a name for the Output
Raster or leave the default to
create a temporary dataset in
your working directory.

8. Click OK.
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Grouping entries

1. Click the 3D Analyst
dropdown arrow and click
Reclassify.

2. Click the Input Raster
dropdown arrow and click the
raster whose values you wish
to group.

3. Click the Reclass Field
dropdown arrow and click the
field you wish to use.

4. Click the New values you
wish to group—click one,
then hold down the Shift key
and click the next one—then
right-click on Group Entries.

5. Optionally, click Save to save
the remap table.

6. Specify a name for the
Output Raster or leave the
default to create a temporary
dataset in your working
directory.

7. Click OK.

Tip

Ungrouping entries
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Changing the classes of
your old values
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164 USING ARCGIS 3D ANALYST

Changing the
classification of input
ranges

1. Click the 3D Analyst
dropdown arrow and click
Reclassify.

2. Click the Input Raster
dropdown arrow and click the
raster whose values you wish
to reclassify.

3. Click the Reclass Field
dropdown arrow and click the
field you wish to use.

4. Click the Classify button.

5. Click the Method dropdown
arrow and choose a classifi-
cation method to use to
reclassify your input data.

6. Click the Classes dropdown
arrow and choose the number
of classes into which to split
your input data.

7. Click OK.

8. Modify the New values for
your output grid if
appropriate.

9. Specify a name for the Output
Raster or leave the default to
create a temporary dataset in
your working directory.

10. Click OK in the Reclassify
dialog box.

Tip

Changing input ranges to
unique values
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Setting specific values to
NoData

1. Click the 3D Analyst
dropdown arrow and click
Reclassify.

2. Click the Input Raster
dropdown arrow and click the
raster with values you wish to
set to NoData.

3. Click the Reclass Field
dropdown arrow and click the
field you wish to use.

4. Click the input boxes for the
New values you wish to turn
to NoData.

5. Click Delete Entries.

6. Check Change missing
values to NoData.

7. Optionally, click Save to save
the remap table.

8. Specify a name for the
Output Raster or leave the
default to create a temporary
dataset in your working
directory.

9. Click OK.

The values you deleted will
be turned to NoData in the
output grid.

Tip

To change a value to
NoData
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Converting rasters and TINs to vector data

Why convert from surfaces to vectors?
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Converting rasters to features
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Raster elevation
model with continuous
values and raster
converted to
categorical values

Polygon feature
class created from
the raster categories

Polygon feature class
of vegetation types
and selected
vegetation that falls
within a selected
elevation class
polygon
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Converting TINs to features
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Raster elevation
model and vector
vegetation feature
class.
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Converting
surfaces to vector
data
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Converting raster data to
features

1. Click the 3D Analyst
dropdown arrow, point to
Convert, and click Raster to
Features.

2. Click the Input raster
dropdown arrow and click the
raster dataset you want to
convert to a feature.

3. Click the Field dropdown
arrow and click the field you
want to copy to the output
features.

4. Click the Output geometry
type dropdown arrow and
click the type of feature you
want to create from your
raster data.

5. Specify a name for Output
features or leave the default
to create a temporary dataset
in your working directory.

6. Click OK.
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168 USING ARCGIS 3D ANALYST

Converting TIN data to
features

1. Click the 3D Analyst
dropdown arrow, point to
Convert, and click TIN to
Features.

2. Click the Input TIN dropdown
arrow and click the TIN you
want to convert to features.

3. Click the Conversion
dropdown arrow and click the
type of conversion that you
want to do.

4. Specify a name for the Output
feature or leave the default to
create a temporary dataset in
your working directory.

5. Click OK.
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Creating 3D
features
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Deriving existing
features’ height from a
surface

1. Add the 2D features and the
surface to a map or scene.

2. Click 3D Analyst, point to
Convert, and click Features
to 3D.

3. Click the Input Features
dropdown arrow and click the
features that you want to
convert to 3D.

4. Click the Raster or TIN
Surface button to set the
source for the features’
heights.

5. Click the dropdown arrow and
click the surface that you
wish to use.

6. Optionally, browse to the
location where you want to
save the output feature class
or shapefile.

7. Type the name of the output
3D feature class or shapefile.

8. Click OK.
Tip

Creating 3D graphics
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Deriving existing
features’ height using an
attribute

1. Add the 2D features to a map
or scene.

2. Click 3D Analyst, point to
Convert, and click Features to
3D.

3. Click the Input Features
dropdown arrow and click the
features that you want to
convert to 3D.

4. Click the Input Feature
Attribute button to set the
source for the features’
heights.

5. Click the attribute that you
wish to use for the features’
heights.

6. Optionally, browse to the
location where you want to
save the output feature class
or shapefile.

7. Type the name of the output
3D feature class or shapefile.

8. Click OK.

Tip

Giving all of the features
the same z-value
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Creating 3D features by
digitizing over a surface

1. Add the 3D feature class—an
existing feature class with
one of the following geom-
etries: pointZ, polylineZ,
polygonZ—to which you want
to add features to the map.

2. Add the surface that you want
to use as the source for the
features’ height to the map.

3. On the Editor toolbar, click
Editor and click Start Editing.

4. If you have more than one
feature class on the map,
identify the workspace of the
feature class in which you will
be creating new 3D features.
Click OK.

5. Click the Interpolate Point,
Interpolate Line, or
Interpolate Polygon button,
depending on the geometry of
the feature class you are
creating.

6. Click on the surface and
create the edit sketch for the
feature just as you would for a
2D feature.

7. When you are finished
digitizing, click Editor and
click Save Edits.

8. Click Editor and click Stop
Editing.

9. Click Yes to save your edits.

Tip

Selecting the surface to
supply z-values
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3D polygon feature
limitation
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Creating 3D graphics by
digitizing over a surface

1. Add the surface that you want
to use as the source for the
graphics’ height to the map.

2. Click the Interpolate Point,
Interpolate Line, or Interpo-
late Polygon button, depend-
ing on the geometry of the
graphics you are creating.

3. Click the surface at the
location where you want to
start drawing.

If you are using the Interpo-
late Point tool, a point will
appear.

If you are using the Interpo-
late Line or Interpolate
Polygon tools, the first vertex
will appear. Click the surface
where you want to create the
next vertex.

4. Double-click the surface to
create the last vertex and
finish drawing.

Tip

Selecting the surface to
supply z-values
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3D polygon graphics
limitation
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Tip

Using 3D graphics in
ArcScene
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3D visualization 7
• Creating a 3D scene

• Adding layers and graphics to a
scene

• Defining 3D properties for layers

• Using the 3D Effects toolbar

• Navigating through a scene using
the Fly tool

• Setting bookmarks

• Defining properties of a scene

• Identifying and selecting features

• Managing viewers

• View settings

• Exporting a scene

• Printing a scene
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Creating a new
scene
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Adding data in ArcScene

1. Click the Add Data button on
the ArcScene Standard
toolbar.

2. Navigate to the surface or
feature data.

3. Click Add.

Adding data from
ArcCatalog

1. Navigate to the data in the
Catalog tree.

2. Click and drag it onto the
scene.
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3D VISUALIZATION 175

Adding data from
ArcMap

1. Right-click the layer in the
ArcMap table of contents and
click Copy.

2. Click the ArcScene window
to make it active, right-click
Scene layers, then click
Paste Layer(s).

Tip

Why is the symbology of
my layer different in
ArcScene?
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Copying and pasting 3D
graphics from ArcMap

1. Click the Select Graphics
button on the ArcMap Tools
toolbar.

2. Click the graphic.

3. Right-click the graphic and
click Copy.

4. In ArcScene, click Edit and
click Paste.

Adding 3D
graphics to a
scene
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Feature data and 3D
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U.S. cities, height extruded based on population in 1990
Building footprints extruded by building height
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Defining the
z-values for a
layer
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Examining the base
heights of a layer

1. Right-click the layer and click
Properties in ArcScene or
ArcCatalog.

2. Click the Base Heights tab.

This layer does not have
base heights.
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Setting the base height
from an attribute

1. Right-click the layer and click
Properties.

2. Click the Base Heights tab.

3. Click the option to Use a
constant value or expression
to set heights for features in
layer.

4. Click the Calculate button.

5. Double-click the field that will
provide the z-value for the
features.

6. Click OK. �
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Using built-in z-values of a
layer
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180 USING ARCGIS 3D ANALYST

7. Click OK in the Properties
dialog box.

The 2D features are now
drawn in 3D, using the
attribute that you selected as
the z-value.

�

Perspective view of contours, base heights set using the contours’
elevation attribute
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Setting a feature layer’s
base heights using a
surface

1. Right-click the layer and click
Properties.

2. Click the Base Heights tab.

3. Click the option to Obtain
heights for layer from surface.

4. Click the dropdown list and
click the surface that you
want to use for the base
heights.

5. Click OK.

The layer is now drawn in
3D, using the surface that
you selected to provide the
z-values.
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Extruding the features in
a layer

1. Right-click the layer and click
Properties.

2. Click the Extrusion tab.

3. Check the check box to
extrude the features in the
layer.

4. Click the Calculate button to
calculate an extrusion
expression. �
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5. Double-click an attribute you
want to include in the
expression.

6. Optionally, build a calculation
that includes the attribute.

7. Click OK.

8. Optionally, click the
dropdown arrow to specify
how the extrusion should be
applied.

9. Click OK. �
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The features are extruded
into 3D.
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Raster data and 3D
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Terrain surface draped over a surface—itself

Aerial photo draped over a surface

Categorical raster draped over a surface

USGS quad map draped over a surface
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Defining the 3D
properties of a
raster layer
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Tip

What is the Raster
Resolution?
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Setting a raster layer’s
base heights using a
surface

1. Right-click the layer and click
Properties.

2. Click the Base Heights tab.

3. Click the option to Obtain
heights for layer from surface.

4. Click the dropdown arrow
and click the surface that you
want to use for the base
heights.

5. Optionally, click Raster
Resolution to set the resolu-
tion of the base surface.

6. Click OK. �
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The raster layer is now
drawn in 3D, using the
surface that you selected to
provide the z-values.
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Converting
z-units to x,y
units
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Converting units

1. Right-click the layer and click
Properties.

2. Click the Base Heights tab.

3. Click the Z Unit Conversion
dropdown arrow and click
one of the predefined types
of conversion.

If you need to apply a custom
conversion, click custom.

4. Optionally, if you’re using a
custom conversion, type the
conversion factor.

5. Click OK.
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Offsetting the
heights in a layer
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1. Right-click the layer and click
Properties.

2. Click the Base Heights tab.

3. Type a constant value for the
offset.

4. Optionally, click the Calculate
button to create an expres-
sion to define the offset.

5. Click OK.
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Controlling when
a layer is
rendered
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Rendering a layer only
when navigation is
stopped

1. Right-click the layer and click
Properties.

2. Click the Rendering tab.

3. Click the option to Render
layer only while navigation
has stopped.

4. Click OK.
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Rendering a layer only
during navigation

1. Right-click the layer and click
Properties.

2. Click the Rendering tab.

3. Click the option to Render
layer only while navigating.

4. Click OK.
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Using the 3D
Effects toolbar
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Turning on the 3D Effects
toolbar

1. Right-click in the blank area
near the menus and toolbars
and click 3D Effects.

The 3D Effects toolbar
appears.
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Using the 3D Effects
toolbar to set a layer’s
transparency

1. Click the Layer dropdown
arrow and choose the layer
you want to change.

2. Click the Adjust Tranparency
button and move the slider to
a value.

�

�

ch07.p65 05/15/2002, 12:55 PM193



194 USING ARCGIS 3D ANALYST

Using the 3D Effects
toolbar to adjust layer
face culling

1. Click the Layer dropdown
arrow and choose the layer
you want to change.

2. Click the Layer Face Culling
button and click the option
you want to use.

The default setting is to view
both sides.

3. Optionally, click a different
viewing option.

View only one side of a layer
to make the data inside it
visible.

Using face
culling to control
the way layers
are drawn
(��	��������� ���������	�
�� 
��
� ��
��������	��� �	� 
���� 
�	�)*
�

	�
�� 
��� ������	��������� 
�

�����

� 
�	����������
� 
���
���
 ����
��	���
������	���
	�
��	���
���������(���	%����	#��
����
���	� ��
�� 
��
� ��� ��������	��  �
�����
���
��� ����	
��	� ��	�� 
��
�� �������#� ��	� �������� 
�� 
���
�

� 
�	����������
���	��
� 
�	
 �������� 
��	�� ��� 
��
� ���� ���
������� �		� ����� ��
�#� 	�	�
��	�� &���	�� ��
���	� �
� 
�	
 �������� 	%
	�
�

�

�

�

ch07.p65 05/15/2002, 12:55 PM194



3D VISUALIZATION 195

Using the 3D Effects
toolbar to change a
layer’s drawing priority

1. Click the Layer dropdown
arrow and choose the layer
you want to change.

2. Click on the Change Depth
Priority button and move the
slider to a value.

Changing a
layer’s drawing
priority
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Viewing a scene from different angles
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Managing scene
viewers
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Adding a viewer

1. Click Window and click Add
Viewer.

Closing a viewer

1. Right-click the title bar of the
viewer and click Close.
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Managing viewers

1. Click Window and click
Viewer Manager.

2. Click a viewer in the Select
viewer list.

3. Click Hide to hide the
selected viewer.

4. Click Show to show the
selected viewer.

5. If you have minimized a
viewer, you can click Restore
to restore it to its previous
size.

6. Click Close Viewer(s) to
permanently close the
viewer.

7. Click OK to close the Viewer
Manager.
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Changing the
viewer settings
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Setting a viewer to 2D

1. Click View and click View
Settings.

2. If you have more than one
viewer for the scene, click the
dropdown arrow and select
the viewer that you want to
change.

3. Click Orthographic (2D view).

You see an orthographic
view of the scene with no
perspective distortion of
scale.

4. Click Cancel to close the
View Settings dialog box.

Tip

Extruded points limitation
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Changing the roll and
pitch of a viewer

1. Click View and click View
Settings.

2. If you have more than one
viewer for the scene, click the
dropdown arrow and select
the viewer that you want to
change.

3. Click the roll slider and drag
it to change the roll.

The artificial horizon and the
viewer roll to the new roll
angle.

4. Click the pitch slider and
drag it to change the pitch.

The artificial horizon and the
viewer pitch to the new pitch
angle.

5. Click Cancel to close the
View Settings dialog box.

Tip

Why can’t I set the roll and
pitch?
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Specifying the
coordinates of the
observer or target

1. Click View and click View
Settings.

2. If you have more than one
viewer for the scene, click the
dropdown arrow and select
the viewer that you want to
change.

3. Type the x,y,z coordinates for
the Observer.

4. Type the x,y,z coordinates for
the Target.

5. Click Apply to set the viewer
to the new observer and
target coordinates.

6. Click Cancel to close the
View Settings dialog box.

Tip

Finding a target’s
coordinates
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Navigating
through a scene
using the Fly tool
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Using the Fly tool to
navigate in a scene

1. Click the Fly button.

The cursor changes to
indicate fly mode is active.

2. Click once in the center of the
scene.

The tool enters the sus-
pended state. You can point
the mouse to look in all
directions, but there is no
translational movement.

3. Click the mouse to move
forward.

Right-click to move in reverse.
Successive clicks in either
direction increase the speed.
Speed is indicated in the
status window.

4. Click the opposite button to
slow down incrementally and
then stop.

Press Esc to immediately stop
movement in either direction.
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Fine-tuning the fly speed
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Tip

Looking up or down while
flying
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Setting
bookmarks
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Creating a perspective
bookmark

1. Navigate to the perspective
for which you want to create
a bookmark.

2. Click the View menu, point to
Bookmarks, and click Create.

3. Type a name for the book-
mark.

4. Click OK.

Using a perspective
bookmark

1. Click the View menu, point to
Bookmarks, and click the
name of the bookmark you
want to use.

The bookmarked view
appears.

Tip

Using bookmarks in
secondary viewers
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Setting the properties of a scene
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Vertical exaggeration emphasizes variation in a surface.

The background color can make visualizations more realistic.

Illuminating a scene from different angles emphasizes different
parts of a surface.
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Changing the
vertical
exaggeration
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1. Right-click Scene layers and
click Scene Properties.

2. Click the General tab.

3. Click the Vertical Exaggera-
tion dropdown arrow and
click a vertical exaggeration
factor.

4. Optionally, click Calculate
From Extent to automatically
calculate an exaggeration
factor based on the extent
and z-variation in the scene.

5. Click OK.
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Using animated
rotation
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Enabling animated
rotation

1. Right-click Scene layers and
click Scene Properties.

2. Click the General tab.

3. Check the check box to
enable animated rotation.

4. Click OK.

The navigate cursor has a
circle around it when
animated rotation is enabled.

Tip

Toggling animated rotation
using shortcut keys
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Starting animated
rotation

1. Click the Navigate button
after enabling animated
rotation.

The navigate cursor has a
circle around it when
animated rotation is enabled.

2. Click the scene, hold the
mouse button down, drag to
the left or right, and release
the mouse button while the
scene is in motion.

The speed at which the
scene rotates is proportional
to the speed at which the
mouse is moving when you
release the button.

Click the scene to stop the
rotation.

�

Changing the rotation
speed

1. While the scene is rotating,
press the Page Up key to
increase the rotation speed
and press the Page Down
key to decrease the rotation
speed.

Tip

Starting animated rotation
with complex data
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Changing the
background color
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Setting the background
color

1. Right-click Scene layers and
click Scene Properties.

2. Click the General tab.

3. Click the Background color
dropdown arrow.

4. Click a color.

5. Optionally, click More Colors
to mix your own background
color.

6. Click OK.
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Setting the default
background color for
future scenes

1. Right-click Scene layers and
click Scene Properties.

2. Click the General tab.

3. Check the check box to use
the current color as the
background in all new
scenes.

4. Click OK.
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Changing the
scene
illumination
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Setting the illumination
azimuth

1. Right-click Scene layers and
click Scene Properties.

2. Click the Illumination tab.

3. Type an Azimuth for the
scene light source.

4. Click OK.

Tip

Changing illumination
properties quickly
:�����
���	�%��
�����
�
������	��	

����#*	������
��#��	�������
����

�
�������	��������&�����
��	�$
	

���������&�	
�������
�	
�����������
����
������	����	
��	�
�����	��
�
�����������
�	
��������������
��	��
���
������������������
�����
	�	�
�

Tip

What is the azimuth?
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Setting the illumination
altitude

1. Right-click Scene layers and
click Scene Properties.

2. Click the Illumination tab.

3. Type an altitude for the scene
light source.

4. Click OK.

Tip

What is the altitude?
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Setting the illumination
contrast

1. Right-click Scene layers and
click Scene Properties.

2. Click the Illumination tab.

3. Type a contrast value.

4. Click OK.
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Tip

What is the contrast?
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Changing the
scene extent
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Setting the extent to a
layer

1. Right-click Scene layers and
click Scene Properties.

2. Click the Extent tab.

3. Click Layer(s), click the
Layer(s) dropdown arrow,
then click the layer you want
to define the scene extent.

4. Click OK.
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Setting the extent using
coordinates

1. Right-click Scene layers and
click Scene Properties.

2. Click the Extent tab.

3. Click Custom.

4. Type minimum and maximum
x and y values to define the
extent of the scene.

5. Click OK.
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Changing the
scene coordinate
system
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Finding out what
coordinate system your
data is currently
displayed in

1. Right-click Scene layers and
click Scene Properties.

2. Click the Coordinate System
tab.

The details of the current
coordinate system are
displayed in the dialog box.
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Displaying data with a
predefined coordinate
system

1. Right-click Scene layers and
click Scene Properties.

2. Click the Coordinate System
tab.

3. Double-click Predefined.

4. Navigate through the folders
until you find the coordinate
system you want and click it.

5. Click OK.

All layers in the scene will
now be displayed with that
coordinate system.
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Tip

Changing the coordinate
system of a scene
0��
�	
�����������	
����
&
������
��
��
�����
�
������������������	�

����
&
�����������
����������
��
��	
���	
�	��

ch07.p65 05/16/2002, 2:50 PM216



3D VISUALIZATION 217

Selecting
features in a
scene
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Selecting features
interactively by clicking
in a scene

1. Click the Select Features
tool.

2. Click the feature you want to
select.

The selected feature is
highlighted.

Changing the interactive
selection method

1. Click Selection, point to
Interactive Selection Method,
and click the selection
method you want to use.

Tip

Learning more about
selection
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Selecting features
interactively by clicking
on a table

1. Right-click the feature layer
and click Open Attribute
Table.

2. Click the row belonging to
the feature you want to
select.

The selected feature is
highlighted.
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Selecting features by
their attributes

1. Click Selection and click
Select By Attributes.

2. Click the Layer dropdown
arrow and click the layer from
which you want to select
features.

3. Click the dropdown arrow
and click the selection
procedure that you want to
use.

The default selection
procedure is to create a new
selection, but you can also
add to, remove from, or
select from the current
selection.

4. Double-click the attribute
field that you want to select
from.

5. Click an operator, for ex-
ample, the equals sign.

6. Double-click a value.

7. Optionally, click Verify to
check your selection
expression.

8. Click Apply.

9. Click Close.

The features are selected.
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Selecting features by
their location

1. Click Selection and click
Select By Location.

2. Click the dropdown arrow
and click a selection method.

3. Check the layers whose
features you would like to
select.

4. Click the dropdown arrow
and click a selection method.

5. Click the dropdown arrow
and click the layer you want
to use to search for the
features.

6. Optionally, check to use only
the selected features.

7. Optionally, check Apply a
buffer to the features in
<layer> and set the distance
within which to search for
features.

8. Click Apply.

9. Click Close.

The features are selected.
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Exporting a
scene
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Exporting a 2D graphic of
a scene

1. Click File, point to Export
Scene, and click 2D.

2. Navigate to the location
where you want to save the
image of the scene.

3. Click the dropdown arrow to
choose the graphics file
format to export.

4. Type the width of the ex-
ported graphic in pixels.

5. Type a name for the graphic.

6. Click Export.

The scene is exported to a
2D image.

Tip

Taking a snapshot of a
scene
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Exporting a 3D VRML
model of a scene

1. Click File, point to Export
Scene, and click 3D.

2. Navigate to the location
where you want to save the
VRML model.

3. Type a name for the VRML
file.

4. Click Export.

The scene is exported to a
VRML file.
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Printing a scene
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1. Click the Print button.

2. Optionally, click Setup.

3. Optionally, click the
dropdown arrow to select a
printer.

4. Optionally, click the
dropdown arrow to select a
page size.

5. Optionally, click Portrait or
Landscape to select the
page orientation.

6. Optionally, click the
dropdown arrow to select a
printer engine.

7. Optionally, click OK.

8. Click OK on the Print dialog
box.
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Animation 8
• ArcScene animation

• Creating animations

• Capturing perspective views in a
scene

• Recording and playing back
animation tracks

� Creating keyframes

� Making group animations

� Making animations from paths

� Using the Animation Manager

• Timing properties in the
Animation Manager

• Saving an animation

� Sharing animations: Loading an
ArcScene Animation file
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ArcScene animation
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The camera and the target
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Introducing the Animation toolbar
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Creating an animation
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Saving an animation
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Sharing animations
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Turning on the Animation
toolbar

1. Click View, point to Toolbars,
and click Animation.

The Animation toolbar
appears as an undocked
toolbar.

Creating
animations
��	�	� ��	� �	�	��������� 
�� ��	�
	
�����
������ ��	� �����	�

�	
���#� ���
������ �	���	�
��	
��	��#� ���5������������� 	����	
��
��������
���+����	������	%
�	
���� �
� ��	�
���� �����
����
��� 
����	�
	������
����� 
���
��
��� �	
��	��  �� �	�	�
	�� ���	

	�
��	�� ��� ���������� ����
�	
���� �	5���	�� ��	��
��� 
��	�
�
� ��
�� ��� 
�	� ��	�	� �
� ���
������	� �����	� ��������
���	������ �����
����

�

Ch08.p65 05/17/2002, 7:32 AM228



ANIMATION 229

Capturing
perspective
views in a scene
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Capturing views to make
an animation

1. Navigate to the perspective
you want to capture.

2. Click the Capture View
button.

3. Repeat to capture more
views as keyframes in a
camera track.

Clearing an animation

1. Click Animation and click
Clear Animation.

All animation tracks are
removed from the scene.

See Also
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Tip

Is there a shortcut to
capturing views?
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230 USING ARCGIS 3D ANALYST

Playing back an
animation

1. Click the Open Animation
Controls button.

2. Press the Play button.

The animation is played
back.

Recording navigation to
create an animation

1. Click the Open Animation
Controls button.

2. Click the Record button.

3. Navigate in the scene using
any navigation tool.

4. Click the Stop button.

A camera track is created,
storing the navigation
sequence.

Recording and
playing back
animation tracks
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Controlling playback and
recording options
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Recording Fly tool
navigation
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Creating
keyframes
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Creating a keyframe of
scene properties

1. Right-click Scene layers and
click Scene Properties.

2. Set the scene property or
properties you want to
capture.

3. Turn on the Animation
toolbar, click Animation, and
click Create Keyframe.

4. Click the Type dropdown
arrow and choose Scene.

5. Click New to create a new
scene track.

6. Click OK.

7. Click Create.

8. Click Close.

You can repeatedly change a
property and create a new
keyframe without closing the
Create Animation Keyframe
dialog box. Note that you
need at least two keyframes
to create a track that will
show change.

Tip

How can I edit keyframe
properties?
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232 USING ARCGIS 3D ANALYST

Creating a keyframe of
camera properties

1. Navigate to the camera
position you want to capture.

2. Click Animation and click
Create Keyframe.

3. Click the Type dropdown
arrow and choose Camera.

4. Click New.

5. Click OK.

6. Click Create.

7. Click Close.

You can change a camera
property by navigating to a
new position and then create
a new keyframe repeatedly
without closing the Create
Animation Keyframe dialog
box. Note that you need at
least two keyframes to create
a track that will show change.

Tip

How else can I create a
keyframe?
:�����
��������%�&�����
���������
2�&�����
�������������#
	���	�

=�
������	����������0�	�%�0�����
���	
��%������0������#
	���	�

2�&�������	����������4�������
	
������	�
$�
���E/
	
�����
#
	���	�
�=�
����8�

Tip

Using bookmarks as
keyframes
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Creating a keyframe of
layer properties

1. Change the layer property
that you want to capture.

For example, turn on the 3D
Effects toolbar and set a
transparency for a layer.

2. Click Animation and click
Create Keyframe.

3. Click the Type dropdown
arrow and choose Layer.

4. Click New.

5. Click OK.

6. Click Create.

7. Click Close.

You can repeatedly change a
property and create a new
keyframe without closing the
Create Animation Keyframe
dialog box. Note that you
need at least two keyframes
to create a track that will
show change.
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Making group
animations
����������	�
	���������
���

�������	%��
�������������	����
����������� ���	�����
���� �� ��	�	�
(���	%����	#���������
����	��
������ ���	�� ��������� ����������
���	��� �	��	�	�
� �������
�� ��

��	���
� 
�	�	� ���	�����	����	�	�
�	5�	�
������ ��� 
�	���-#� ���
���� ��	�
	� 
������ 
��
� ����	�/
���	��� 
�������� ���
����������



���	���� ���	����
���� 
�	�������
��	������
����������	�	�����

�	����	�������� 
�	���-#���
������	� ���	��� ��� 
�	� ���	�� 
��

�������
� 
�	������	��� ��	

��������������������
�	���
�
�����	�� 
������� 
��	�

Making a group
animation

1. Click the Add Data button to
add the layers or group layer
that you want to animate.

2. Click Animation and click
Create Group Animation.

3. Optionally, choose a Base
name for tracks.

You are provided with a
default name for the tracks,
but you can change it to
something more meaningful.

4. Optionally, set the beginning
and ending times.

Setting these times allows
you to determine when the
group animation will play
relative to other tracks that
may exist.

5. Select a group layer. You can
click a group layer or all the
layers in your scene.

6. Optionally, change
Transitions.

These options will help you
determine how layers in an
animation change from one
to another.

7. Optionally, uncheck Over-
write existing tracks with
same name to add additional
group animations.

8. Click OK.
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Making
animations from
paths
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Making a camera flyby
from a path

1. Click a selection tool and
select the line feature or
graphic you want to use as a
path.

2. Click Animation and click
Camera Flyby from Path.

3. Optionally, check Apply in
reverse order.

The camera will begin at the
other end of the path.

4. Optionally, type a value in the
Vertical offset text box.

An offset defines the height
of the camera.

5. Optionally, slide the
simplification factor.

The simplification factor
determines how much the
path will be generalized for
the animation.

6. Optionally, choose a path
destination.

Change the path destination
to determine how the
observer and target are
positioned during the
animation.

7. Optionally, uncheck Over-
write last imported track.

Disabling this option will
allow you to add tracks to
previous ones.

8. Click Import.

Tip

Modifying camera
properties
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236 USING ARCGIS 3D ANALYST

Moving a layer along a
path

1. Click a selection tool and
select the line feature or
graphic you want to use as a
path.

2. Click Animation and click
Move Layer along Path.

3. Click the Layer dropdown
arrow and choose the layer
you want to move.

4. Optionally, check Apply in
reverse order.

This option will start the layer
moving from the opposite
end of the path.

5. Optionally, type a value in the
Vertical offset text box.

The vertical offset determines
the height of the layer.

6. Optionally, slide the
simplification factor.

The simplification factor
indicates how much the path
will be generalized when it is
used for the animation.

7. Optionally, uncheck Over-
write last imported track.

Disable this to allow addi-
tional layer tracks to be
imported without overwriting
existing ones.

8. Click Import.
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Tip

Using advanced layer
orientation settings
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Using the
Animation
Manager
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Using the Animation
Manager to access
keyframe properties

1. Click Animation and click
Animation Manager.

2. Click the Keyframes tab.

3. Click the Keyframes of Type
dropdown arrow and choose
the type of keyframe you
want to examine.

4. Click the In Track dropdown
arrow and choose the
specific track you want to
access.

5. Click a Keyframe property to
change it.

6. Press Enter.

7. Click Close.

Tip

Why change a track or
keyframe property?
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Updating a keyframe
����	
����
����
��
�����������
%�&������	
�����#
	���	�

=�
����$�
����������%�&������&��
��
��������
���	
�����2�&�����

����$����	�&������������&�	
����

��
�$��
����	�%�/����������
%�&�������	������������������������
�������
���

�

�

� �

��

Ch08.p65 07/18/2002, 2:05 PM237



238 USING ARCGIS 3D ANALYST

Using the Animation
Manager to access track
properties

1. Click Animation and click
Animation Manager.

2. Click the Tracks tab.

3. Optionally, check View only
tracks of type, click on the
dropdown arrow, and select
the type you want to
examine.

4. Click a Track property to
change it.

5. Press Enter.

6. Click Close.

Tip

Changing a track’s priority
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What is binding?
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Can I interact with an
animation track?
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Using the Animation
Manager to modify timing
properties of tracks

1. Click Animation and click
Animation Manager.

2. Click the Time View tab.

3. Optionally, click the Plus or
Minus buttons to change the
time scale.

Reducing the time scale
gives you a more detailed
view.

4. Optionally, check View
enabled tracks only.

Using this option shows only
the tracks that are currently
enabled. Disable a track in
the Tracks page.

5. Click and drag a green
keyframe box in a track to
change the time when it will
be played.

Moving a keyframe to a later
point in the track will make it
be played later in the
animation.

Click and drag a keyframe at
the start or end of a track to
determine when that track
will play relative to others.

6. Click Close.

Timing properties
in the Animation
Manager
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Previewing an animation
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Why are my layer tracks
colored differently?
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Saving an animation in a
scene document

1. Click the Save button.

An existing scene document
will be appended with the
animation, or if none exists,
you will be prompted to
provide a name for a new
document that will contain
the animation.

Saving an
animation
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Saving an animation by
exporting tracks to an
ArcScene Track file

1. Click Animation and click
Save Animation File.

2. Click the Save in dropdown
arrow and choose a location.

3. In the  File name text box,
type the name you want to
give the animation file.

4. Click Save.
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Exporting an animation
to a video file

1. Click Animation and click
Export to Video.

2. Click the Save in dropdown
arrow and choose a location.

3. In the File name text box,
type the name of the video
file you want to create.

4. Click Export.

A .avi file of the given name
is created in the specified
location.

Tip

Using advanced video
options
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Tip

Preventing extraneous
windows from appearing in
video files
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Sharing
animations:
Loading an
ArcScene
Animation file
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Loading an ArcScene
Animation file

1. Click Animation and click
Load Animation File.

2. Browse to the ArcScene
Animation file you want to
load.

3. Click Open.

Tip

Identifying ArcScene
Animation files
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Tip

Using animations stored in
a scene document
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